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KEGGscape constructs KEGG pathway on Cytoscape3 (formerly known as KGMLReader for Cytoscape 2.%).

In contrast to KEGG web, you can edit the network and map your data as you like.

Contents 1
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CHAPTER 1

Installing KEGGscape

KEGGscape source code is distributed as open source software under the Apache License, Version 2.0 and is available
at GitHub.

https://github.com/idekerlab/KEGGscape
KEGGscape requires Cytoscape version 3.6. First you need to download Cytoscape from
http://cytoscape.org/download.html

You can install KEGGscape with Cytoscape app manager.



https://github.com/idekerlab/KEGGscape
http://cytoscape.org/download.html
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CHAPTER 2

How to import KEGG pathway xml(kgml) to Cytoscape

First we show how to import KEGG pathway xml(kgml) to Cytoscape.

2.1 Importing kgml to Cytoscape with REST endpoint

KEGGscape exposes a REST endpoint to directly import a KEGG pathway entry and it is documented in the main
Swagger page generated by CyREST (available under: Help -> Automation -> CyREST API).

localhost:1234/v1/swaggerUl/swagger-ui/index.htmi?url=http%3A%2F%2Flocalhost%3A1234%2Fv1%2Fswagger.,json

{} | SWagger hitp:/flocalhost: 1234/v1/swagger.json Explore

CyREST API

A RESTful service for accessing Cytoscape 3.

Cytoscape
http://cytoscape.org/

Apps Show/Hide | List Operations | Expand Operations
Apps: CyNDEx-2 Show/Hide Expand Operati
Apps: Diffusion sho Expan

Apps: KEGGscape sho Expan
Collections Show/Hide Expand Operati
Commands Show/Hide | List Operations | Expand Operations

You can import kgml to Cytoscape with filling the KEGG pathway ID and clicking the “Try it out!” button.
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1 SWagger http:/flocalhost: 1234/v1/swagger.json Explore

CyREST API

A RESTful service for accessing Cytoscape 3.

Cytoscape
http://cytoscape.org/

Apps
Apps: CyNDEx-2

W
=
o

yw/Hide | List Operations | Expand Operations

]
=0
o

yw/Hide | List Operations | Expand Operations

AppS: Diffusion Show/Hide | List Operations | Expand Operations
Apps: KEGGscape Show,/Hide | List Operations = Expand Operations
/keggscape/v1/{pathid} Import a KEGG pathway and create the network view

Implementation Notes
KEGGscape will import the KEGG pathway (specified by {pathid}) into Cytoscape.

For example, /keggscape/v1/eco00010 imports http://www.genome.jp/kegg-bin/show pathway?eco00010 into Cytoscape.

You can try it by filling 'eco00010" in the following 'Value box' and clicking "Try it out!" button.

Parameters

Parameter Value Description _FF"aI';%meter Data Type

pathid leco00010| KEGG pathway ID path string

Response Messages

HTTP Status Code Reason Response Model Headers

default successful operation

2.2 Importing kgml to Cytoscape by manually downloading kgml

2.2.1 Downloading KEGG pathway kgml

You can download KEGG pathway kgml without opening web browser (if you know the KEGG pathway entryID you
want to import).

wget http://rest.kegg.jp/get/eco00020/kgml -0 eco00020.xml

eco00020.xml is TCA cycle of Escherichia coli K-12 MG1655.

2.2.2 Importing kgml to Cytoscape by GUI

You can import kgml to Cytoscape from menu bar
File -> Import -> Network -> File

and open eco00020.xml.

6 Chapter 2. How to import KEGG pathway xmi(kgml) to Cytoscape
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shared. | name | KeGG_.| KeGG_.| KeGG_.| KecG_.| KeGG_.| KecG_.| KeGo_.| Keceip| KkeGG_.| KecG_.| KeGG_.| KeGG_.| KEGG_.
27 27 144 530 [ 7 sdhC..  sdnC..  [sdnC.] [ecob.. #000000 #BFFFBF  mRO0.. gene rectangle
28 28 505 649 46 17 K0017.. K0017.. [KOO17.. [koKO.. —#000000 #FFFFFF  mROL. ortholog rectangle
29 29 446 618 46 17 Ipd Ipd Ipd] ecorb..  #000000 #BFFFBF  rRO7.. gene rectangle
30 30 640 574 46 17 sucA sucA sucA]  [ecob.. #000000 #BFFFBF  mROQ.. gene rectangle
31 31 509 575 46 17 sucA sucA sucAl  [ecob.. #000000 #BFFFBF  mRO3.. gene rectangle
32 32 382 574 46 17 sucB sucB suct] ecob..  #000000 #BFFFBF  rmRO2.. gene rectangle
33 33 239 585 46 17 sucC..  sucC.. [sucC..] [ecob.. #000000 #BFFFBF  mROO.. gene rectangle
34 34 239 564 46 17 K0189.. KO189.. [KOL8Y.. [koKO.. —#000000 #FFFFFF  mR00.. ortholog —rectangle
35 35 697 505 46 17 icd icd icd] ecob..  #000000 #BFFFBF  rRO0.. gene rectangle
[T edge Table | Network Table |
(Memory-ox @ ]

2.3 How to bundle edges

KEGGscape creates two edges for a reversible reaction, if you want to bundle these reversible reactions like KEGG,
please select “Bundle edges” from “Layout” menu.

2.3. How to bundle edges 7
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CHAPTER 3

Combination of Python scripts and KEGGscape

Scripting language support is an experimental feature in Cytoscape 3.
Cytoscape 3 supports scripting language. Here we show a sample of Python + KEGGscape.

We import all Ecoli pathways to Cytoscape.

3.1 Importing all KEGG pathways of Escherichia coli K-12 MG1655

First we download all Ecoli pathways with the following Python script. This script requires requests Python package.

import requests
ORGANISM = "eco"

pathways = requests.get ('http://rest.kegg.jp/list/pathway/"' + ORGANISM)
for line in pathways.content.split('\n'):
pathwayid = line.split ('\t') [0].replace('path:', '")
kgml = requests.get ('http://rest.kegg.jp/get/' + pathwayid + '/kgml")
f = open(pathwayid + '".xml', 'w'")
f.write (kgml.content)
f.close

You will get all eco KGMLs like this.



http://docs.python-requests.org/en/latest/
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800 I_:I KEGGscape x —
[«]»] 2 BEhENERIERIERIEIIE) Q
FAVORITES
£3 Dropbox - - » - - - - -
D AirDrop e e o o = e e e
# Applications 2co00010.xml co00020.xml eco00030.xml ec000040.xml eco0005 1.xml 2co00052.xml 2co00053.xml 2co00061.xml
|| Desktop
@ Documents s s N N N N N N
0 Downloads
= Movies XML =L | XML =T =AML =X =X =X
n Music eco00130.xml eco00190.xml eco00230.xml eco00240.xml eco00250.xml eco00260.xml eco00270.xml eco002B0.xm!
Pictures
[CJ Google D... - - - - - - - -
pEvICEs e . T o ST e e e
TAGS eco00290.xml eco00300.xml eco00310.xml eco00330.xml eco00340.xml eco00350.xml eco00360.xml eco00361.xml
@ Red
Orange b b L N L L s s
Yellow
Green =X XML | | XML = 0. AL =X . =X
@ Blue eco00363.xml eco00364.xml| eco00380.xml eco00400.xml eco00401.xml eco00410.xml eco00430.xml eco00440.xm|
@ Purple
Cray - - - - - - - -
All Tags...
=X XML =L =R XL | =AML =X =X
eco00480.xml eco00471.xml eco00473.xml eco00480.xml eco00500.xml eco00511.xml eco00520.xml eco00521.xml

Next we show a sample to batch-import kgml files from Python script. To use Python from Cytoscape3, you need to
download jython-standalone from here , and move the jython-standalone like this.

Now you can batch-import kgml files with Python. Here we import all carbohydrate metabolism kgml files. (Of course
you can import all pathways, but it takes time and cys file get so big.)

mkdir carbohydrate

mv eco00010.xml eco00020.xml eco00030.xml eco00040.xml eco00051.xml
eco00052.xml eco00053.xml eco00500.xml eco00520.xml eco00562.xml
eco00620.xml eco00630.xml eco00640.xml eco00650.xml eco00660.xml

next run cytoscape3, go in osgi shell and run following Python script(save as load_kegg.py).

from java.io import File

KEGG_DIR = "/ABS_PATH_TO/carbohydrate/"

pathways = ["eco00010.xml", "eco00020.xml", "eco00030.xml", "eco00040.xml", "ecoOO0051.
—xml", "eco00052.xml", "eco00053.xml", "eco00500.xml", "eco00520.xml", "eco00562.xml
—", "eco00620.xml", "eco00630.xml", "eco00640.xml", "eco00650.xml", "eco00660.xml"]

loadNetworkTF = cyAppAdapter.get_LoadNetworkFileTaskFactory ()
taskManager = cyAppAdapter.getTaskManager ()

allTasks = None

for pathway in pathways:
kgmlpath = File (KEGG_DIR + pathway)
print str (kgmlpath)
itr = loadNetworkTF.createTaskIterator (kgmlpath)
if allTasks is None:
allTasks = itr
else:
allTasks.append (itr)

(continues on next page)

10 Chapter 3. Combination of Python scripts and KEGGscape
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(continued from previous page)

taskManager.execute (allTasks)

Save this Python script as load_kegg.py. To run load_kegg.py, type (from Cytoscape3 OSGi shell)

cytoscape:script python /ABS_PATH_TO_SCRIPT/load_kegg.py
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3.1. Importing all KEGG pathways of Escherichia coli K-12 MG1655
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CHAPTER 4

Mapping drug targets on KEGG pathway

Here we show a example of data integration. We map drug targets(from Drugbank) on KEGG pathway. To manage
several tables, we use MongoDB and PyMongo.

4.1 Importing all data into MongoDB

First we export node attribute table of Alanine, aspartate and glutamate metabolism as alanine_nodes.csv.

8006 Recent Session > B Sessian: [Users/knishida/Di B — i o— =
New > |
ICRCRE = x| W &QaQq § oo |
Control Panel ‘ Save S ‘x CEEK::) 2
Save As... %8S
TNework _ Import =
i, Alanine, aspartatelad ALY » Network...
Alanine, aspal Network and View ...
... Glycine, serine ani RUN-.. Network View as Graphics... Q
Glycine, serine
. Cysteine and mert  Pint Current Network... 3P Sl A
Cysteine and methionine metabolism 143(0) 148(0) A
... Valine, leucine and isoleucine degradatio L
Valine, leucine and isoleucine degradi108(0) 43(0)
+:a Valine, leucine and isoleucine biosynthes
Valine, leucine and isoleucine biosyntiS1(0)  65(0) L
iia Lysine biosynthesis b
Lysine biosynthesis 83(0) 43(0)
.:. Lysine degradation
Lysine degradation 88(0)  19(0) 5
.. Arginine and proline metabolism
Arginine and proline metabolism ~ 216(0) 221(0)
iix Histidine metabolism
Histidine metabolism 83(0)  31(0) C
... Tyrosine metabolism
Tyrosine metabolism 164(0) 28(0)
.. Phenylalanine metabolism L
Phenylalanine metabolism 141(0) 111(0) s
saa Tryptophan metabolism
Tryptophan metabolism 155(0) 18(0)
... Phenylalanine, tyrosine and tryptophan b 0 "‘—\—ﬂ
mital o -
- Table Panel Ox
& [0 == oo [§ @@ =0 f(z) [Alanine, asp and i ]
shared.| name | KEGG.| KEGG..| KEGG .| KEGG..| KEGG..| KEGG .| KEGG..| KEGGID| KEGG..| KEGG .| KeGG..| |
135 135 338 714 46 17 K16871 K16871 [K16871] [ko:K1..  #000000 #FFFFFF m:R10...  or
134 134 250 58 419 25 TITLE...  TITLE... [TITLE... [pathce.. #000000 #32CCB6 m
133 133 518 597 8 8 C00014  Ammo. [C00014] #000000  #FFFFFF co
132 132 478 930 198 25 C5-Bra... C5-Bra.. [C5-Br... #000000  #E999AE m
131 131 515 902 122 25 Butano... Butano.. [Butan... #000000  #B6999AE m
130 130 498 874 156 25 Cyano... Cyano.. [Cyano... #000000  #6999AE m
129 129 511 846 131 25 Porphy...  Porphy... [Porph... #000000  #E999AE m
128 128 510 818 131 25 Glutat.. Glutat.. [Glutat... #000000  #B6999AE m

TEEEE Edge Table | Network Table |

Memory: OK
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Next we download drug targets from Drugbank and id convert table with KEGG REST API.

wget http://www.drugbank.ca/system/downloads/current/all_target_ids_all.csv.zip
unzip all_target_ids_all.csv.zip

wget http://rest.kegg.jp/conv/eco/uniprot

mv uniprot conv_eco_uniprot.tsv

Finally we import these tables into mongodb.

mongoimport --db keggscape --collection alanine_nodes —--headerline --type csv —--file_
—~alanine_nodes.csv

mongoimport --db keggscape —--collection all_target_ids_all --headerline —-type csv —-—
—file all_target_ids_all.csv

mongoimport --db keggscape —-collection conv_eco_uniprot —-f uniprot_id,kegg_id —-type,,
—tsv —-—-file conv_eco_uniprot.tsv

4.2 Merging tables with PyMongo

We integrate the three table(network nodes, drug targets table, id conversion table). Here we append columns drug
target and drug to Cytoscape’s node table.

from pymongo import MongoClient

client = MongoClient ()
db = client|['keggscape']

(continues on next page)
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(continued from previous page)

node_collection = db['alanine nodes']
drug_collection = db['all target_ids_all']
conv_collection db['conv_eco_uniprot']

gene_table = node_collection.find ({"KEGG_NODE_TYPE": "gene"})

for genes in gene_table:

locuses = genes["KEGG_ID"].split ("\r") #newline character depends on your 0S, T
—exported cytoscape table on Mac

for locus in locuses:

ids = conv_collection.find_one ({"kegg_1id": locus})

drug = drug_collection.find_one ({"UniProt ID": ids["uniprot_id"].replace ("up:
;}", llll)})

if drug != None:

node_collection.update ({"_id": genes["_id"]}, {"$push": {"drug_ids": drugl
—"Drug IDs"], "target_id": drug["ID"], "target": locus}})
node_collection.update ({"_id": genes["_id"]}, {"Sset": {"is_target": 1}})

Next we create fields.txt to export the new node table.

shared name
drug_ids
target_id
target
is_target

and export node table as csv.

mongoexport ——-db keggscape --collection alanine_nodes —--csv ——fieldFile fields.txt ——
—out alanine_drugs.csv

import this alanine_drugs.csv into Cytoscape and highlight drug targets as below.

4.2. Merging tables with PyMongo 15
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CHAPTER B

Mapping genome scale metabolic model on KEGG pathway

Here we show the other example of data integration. We map iAF1260(a genome-scale metabolic reconstruction for
Escherichia coli K-12 MG1655 that accounts for 1260 ORFs) on KEGG pathway.

5.1 Importing iAF1260 into MongoDB

You can download iAF1260 reaction table from ModelSEED.

19
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Seed Viewer - Model SEED

Seed Viewer - Model SEED MT[
dviewer.cgi?model —IAF1260& ot 77 = & | (B~ coogle Q) (B~ |§| [

| @ seed-viewer.theseed.org/

2 The Model SEED

Welcome to the Model SEED - a resource for the generation, optimization, curation, and analysis of genome-scale metabolic models.
For more information about The SEED please visit theSEED.org.

Important Server Messages:
1.) We recommend using the Firefox browser to view this website.

You have chosen to open:

Model SEED Tutorials {Click here to view) ¥ table.tsv
Seloctod mode | o which is: tsv File (717 KB)
e models and run from: hitp://seed-viewer.theseed.org

What should Firefox do with this file?

O openith
GSave File

type here to see available models

(Example search: 'bacillus’, ‘coli’, 'Seed85962.1')

Model ID Organism Version Source t:ﬂlling Compounds Download
ia

W iAF1260 Escherichia coli K12 o [] Do this automatically for files like this from now on. Carbon- 1,042 zsilfm (remove)
(83333.1) D-Glucose LP format

b
el ok |

Click here to run FBA on selected models

| export table |

chky[50_ |t e e

displaying 1 - 50 of 2019 nexts last»

Subsystems . ¥ $EGG maps i Er{zyme KEGG Notes iAF1260 ;v

-
I -

Il;lctlun Name ¥ Equation . ¥
F A

Inorganic pyr

rxn00001 [Pyrophosphate H20 + PPi == (2)
(EC 3.6.1.1)

phosphohydrolase Phosphate + (2) H+

Manganese-dependent
inorganic pyrophosphatase
(EC 3.6.1.1)

and import this table into MongoDB, like this.

mongoimport —--db keggscape —-collection i1iafl260 --type tsv —-—-headerline --file table.

—tsv

and export Galactose metabolism pathway from Cytoscape and import it like this.

mongoimport ——-db keggscape —-collection galactose_node -—headerline —-type csv ——file

—galactose_node.csv

This Python script append column which enzyme genes differ between KEGG and iAF1260.

from sets import Set
from pymongo import MongoClient

client = MongoClient ()
db = client|['keggscape']

node_collection = db['galactose_node']
model_collection = db['iafl260"']

kegggene_table = node_collection.find ({"KEGG_NODE_TYPE": "gene"})
modelreaction_table = model_collection.find({"KEGG RID": {"Sregex": "R[0-9]{5}"}})

for kegggene in kegggene_table:
kegggenes = kegggene['KEGG_ID'].split ("\x")
keggonly_genes = []
modelonly_genes = []

(continues on next page)
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(continued from previous page)

for keggreaction in kegggene['KEGG_NODE_REACTIONID'].split (" "):
modelkeggreaction_table = model_collection.find ({"KEGG RID": {"Sregex": |

—keggreaction.replace("rn:", "")}})

if modelkeggreaction_table.count () > 0:
for modelkeggreaction in modelkeggreaction_table:
modelgenes = modelkeggreaction['iAF1260\r'].strip() .replace("<br>",
—"eco:") .split (", ")
if Set (kegggenes) != Set (modelgenes):
keggonly = Set (kegggenes) - Set (modelgenes)
modelonly = Set (modelgenes) - Set (kegggenes)

if len(keggonly) > O:
node_collection.update ({"_id": kegggene["_id"]}, {"S$push":

—"keggonly": " ".join (keggonly) }})
else:
node_collection.update ({"_id": kegggene["_id"]}, {"S$push":
—"modelonly": " "_.join (modelonly) }})

{

{

And export galactose_node collection and reimport to Cytoscape.

mongoexport ——-db keggscape —--collection galactose_nodes —-csv ——-fieldFile genediff_
—fields.txt —-—-out new_galactose_nodes.csv

Here is the annotation difference between iAF1260 and KEGG

5.1. Importing iAF1260 into MongoDB
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Session: [Users/knishida/Dropbox/jstdata/carbohydrate/carbo.cys w 1
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Table Panel 0O x
. m 2 OO B @ mo f(x) | Galactose metabolism =
GG_.| KEGG_.| KEGG_.| KEGG..| KEGGID| KEGG..| KEGG_.| KEGG..| KEGG_..| KEGG_..| A modelonly keggonly
pgm pgm [pgm] [eco:b...  #000000 #BFFFBF m:R00...  gene rectangle ["eco:b2690"]
galkK galk [galK] [eco:b...  #000000 #BFFFBF m:R01... gene rectangle ["eco:b2045"]
lacZ... lacZ... [lacZ...] [ecob... #000000  #BFFFBF rm:ROL...  gene rectangle [ "eco:b3076 eco:b3077"]
galU... galU... [galu...] [ecotb...  #000000 #BFFFBF rm:RO0...  gene rectangle ["eco:b2042" ]
pfkB... pfkB... [pfkB...] [ecob... #000000  #BFFFBF m:RO3... gene rectangle [ "eco:b1723" ]

Wl Edge Table | Metwork Table | Unassigned Tables |

Memory: OK .

This work was supported by the National Bioscience Database Center(NBDC) program Database Integration Coordi-
nation Program (Tool Prototype for Integrated Database Analysis)
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